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Welcome to Merrowly 
Merrowly is a part of the Embrilliance Platform, a suite of products that operate within one 

program interface on Mac and Windows PCs. 

Everyone loves patches. We collect them to show where we ’ve been, what we enjoy, and who we 

are, inside and out. 

 

Merrowly is a versatile software tool and an extensive collection of resources to allow you to 

create beautiful patches. 

Merrowly is based on a program machine embroidery stitch that can emulate an overlock, or 

merrowing, on the edge of a patch. The patch edge has been a standard for over 100 years, and 

has a distinctive look. When you have a Merrowly patch in your hand, you feel as  though this was 

made with traditional tools and skill on the overlock. The amazing part is that you can use only an 

embroidery machine, thread and stabilizer to get one-of-a-kind patches. 

A basic feature list includes: 

 Merge and save machine embroidery design files from virtually any source.  

Export cut-files. 

Create patch edges to wrap a page, as a circle/oval, square/rectangle with adjustable 

corner radius. 

Use pre-made patches or choose from well over 100 shapes in the included Library.  

  Includes two sets of fonts: Uniform/Block small + micro and 60wt. and Fun fonts for name 

patches or any other embroidery use.  

Color Sort for multiple-patch layup. 

Create objects compatible with StitchArtist 3. 

Merrowly comes with patch shapes that have been used on commercial uniforms for many years. 

These shapes are the same size and aspect ratio as you would expect when creating police, fire and 

military patches for actual use by responders. Included are rockers and namedrop templates for 

ease of use. 
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Merrowly also comes with two sets of fonts: One set is designed for those uniform pieces, and the 

other is for fun. Uniform patches often require official versions of block text, specifically chosen to 

match a style guide or service. In embroidery, the designer can often use a nearest-matching font 

and adjust single letter shapes as needed. In this set, however, there are not only block fonts, but 

sets of fonts with mini and 60wt small versions. And there are several United States military 

branch fonts included, designed to fit the style guide of those branches. 

For fun, there is a collection of fonts with various styles from swirly, retro to motorcycle. One 

major benefit of this set is that a patch can be made, one that exactly outlines a name made using 

the fonts. 
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Merrowly can automatically create a patch for anything on the design page. With a single menu 

selection (Utility > Add Patch Edge) you can automatically wrap the page designs in a custom 

shaped patch edge or a circle, rectangle or rounded rectangle (with adjustability).   
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Installing 
If you are unfamiliar with the Embrilliance Platform itself, please do read the help or manual (same 

content.) It will explain things like serial numbers and how they activate different parts of the 

program. 

When the program runs, it checks your serial numbers to see what products are licensed. If none 

are, this is a free mode called, ‘Express’ which will also present a window for you to enter a serial 

number if you have one. Here, you type in your Merrowly serial number. If you already have serial 

numbers in the Platform, use the Help menu > serials to add the number. You will have to restart 

the program (not the PC). 

Merrowly contains a lot of content; designs, fonts, etc. which take up some space. As such, that 

content is not all installed with the Platform. You will need to use the Embrilliance downloads page 

to get the installer for that content. It will come as an Embrilliance installer file with the .BX 

extension. You may have seen that on many fonts sold by nearly everyone in the industry.  

Once installed and run with the serial number, Merrowly adds a command to the File menu > 

Export Outlines which is used to save a cut-file for the patch shape. There is also the Utility menu 

which includes Add Patch Edge with three options for Circle/Rectangle/Page Wrap. In the Library 

the Embrilliance: Merrowly collection will be added with several sets of designs, sorted by shape or 

utility. 
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Understanding Patches 
Knowledge of the basic construction of a patch is necessary. A patch will consist of some optional 

steps: 

Position: Use this to establish where in the hoop the patch will be embroidered. Any applique 

would normally fully cover this stitch. Position stitches can also be used on fabric to create cut-

lines so that the fabric can be hand-cut into appliques. 

Material: When an applique fabric has been placed, it will be anchored with stitches.  

Topstitch: The actual faux-overlock edge of the patch. 

Design elements: Any names or designs of your choosing that will be contained in the patch.  

For many, if not most, cases, the entire patch steps can be completed before the design elements. 

For beginners, this is the recommended method. When making patches, try to use designs that ar e 

lightly stitched. 

If you think your design will pull the completed patch away from the stabilizer, you can sew the 

topstitch of the patch edge as a final step. To do this, wait until your design is complete, then copy 

the patch design. Paste it. This will place it over top of the original, but it will be the final design in 

the sewing sequence. Then you can adjust the properties of the patch to cause the final one to sew 

only the edge, and have the initial one not sew that edge. This ability to make patches in 2 steps, 

with the design elements between, does mean that the patch may shift slightly in the hoop before 

the final stitch, and registration could be an issue. You’ll have to look closely at it, or simply try it.  
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Patch Creation 
Merrowly provides a controlled Interactive design for the patch. Construction styles are selectable.  

 Freestanding: Patches can be made from only thread with a freestanding background on an 

appropriate stabilizer (wash-away, vinyl, etc.) 

 Directly on yardage: Simply embroider as normal and cut or hot-cut later. 

 Applique: Traditional methods can be used. You can also save a cut-file or .svg to allow for 

electronic cutting. If you do not have the perfect color fabric, Merrowly has the option to 

add a light sketch-style fill for color and texture to the background of the patch.  

 

Options for patch types 

Step options 
There are three basic steps in an applique, which essentially is how a patch is constructed. There is a 

position stitch, which runs showing the machine operator where the applique or patch fabric will need 

to be in the hoop. The Material stitching sews the applique in place, or replaces it using a fill. Then the 

final edge, that which makes the faux-overlock, is called the topstitch. 

Selectively checking or unchecking the boxes for the stitch steps is used in situations where the patch is 

assembled in other orders, for instance, when the topstitch is desired to run as a final step after all the 

rest of the patch is complete. Then, there are actually two patch designs, identical to each other, with 

the earlier one doing all the non-topstitch work, and the final one doing only the topstitch work. 
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Understanding patch types (material) 

Cut When Complete 

 When stitching the patch directly onto yardage, the patch will need to be cut from the 

cloth once it is completely sewn. This process requires no applique steps, so they are removed 

from the automation of the patch edge. 

Using Pre-Cut 

 A pre-cut applique is created either by hand or machine. Selecting this option ensures that 

the position step is made, but the material tackdown is run with the topstitch, saving a color stop.  

 Hand Cut in Hoop 

 This option ensures all color stops. The position stitch runs, then the user lays the fabric 

over it. This is followed by a tackdown stitch in a separate color. The machine then stops and the 

user carefully cuts the edge of the applique off, while the project is still hooped. Once the excess 

material is cut away, the topstitch is run, including the patch design itself.  

 Create Using Fill 

 When stabilizer is hooped without fabric and no applique is desired, this will create a fill 

similar to a freestanding lace fill. Normally, wash-away mesh stabilizer or vinyl backings are 

hooped, but there are others, such as light cut-away (if you are good at cutting it closely.) 

 This method is a favorite when the exact color twill is unavailable, or a very few patches 

are being made. 

Add Light Fill 

 Sometimes the twill color is not exact for the desired result, or there may be an artistic 

reason for wanting to add texture and color to the background of the patch before the design is 

sewn. The light fill option adds that color and texture using a horizontal fill that will not affect the 

overall density of the patch in any noticeable way. 

 The Advanced version of this has additional properties for the user to control, however this 

is not normally adjusted. It is added here for those skilled digitizers who want to make slight 

adjustments to refine their patch. 

 

Density, Stitch length and Angle are adjustable in the Light Fill (Advanced).  
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Utility > Add Patch Edge 
The Utility menu will have an added option when Merrowly is installed. Add Patch Edge will create patch 

shapes in three styles: Rectangle, Circle, Page Wrap. 

 

Three types of automatic patch creation. 

 

Rectangle, with curved-corner properties. 

 

Circle which can be sized to form an oval. 

 

Automated shape that wraps the design on the page. 
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Lettering 
Some patches come pre-made with lettering baselines. To use these, add a lettering design to the 

page, and be sure it is positioned after the patch design itself. The lettering will generate when you 

type in the text box, telling it what to say.  

Baselines and Templates 
Many of the included designs hold one or more baselines or templates. A baseline is merely a position 

that the text will appear within the design. The baseline is added by the digitizer to help you with the 

placement of your lettering. 

A template is a shape into which a lettering design will be positioned and distorted. 

The use of baselines or templates in the design is up to the user. There is a lot more information on 

those topics in the Embrilliance Platform manual. 

To specify the lettering will use the baseline or template, rename the lettering design by adding a 1 

to the end of the name. The lettering will then position itself to the baseline automatically.  

Where there are two baselines, rename the second lettering design by adding the number 2 after 

it, ex: Letters 2. 

 

The number 1 is used after the name in order to link the lettering to the template 

in the baseball design. 

Where a template is used, the same naming convention applies. When a lettering design that ’s 

used in a template is selected, it is not shown as it will appear in the template. This allows for 

adjustment of character position relative to each other. To see the design in the template, click off 

it to deselect it. 
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Left: Lettering design is not selected. Right: Lettering is selected. 

When using templates and baselines, the number of each is required, in order for the program to 

match the lettering to the correct one. Some designs have multiple placement objects, therefore 

the Notes tab is used to display the numbers required. 

 

Use Notes tab to see the template name linkage. 

Some baselines will require you to use additional commands for centering, using the top of the 

text to apply to the line, etc. In this case, command flags are used in the names, following the 

number. Ex: Letters 1 –c –t which means use template item 1 with centered on top of the text. 
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On some designs there is the option to use a baseline or an envelope, which provides a different 

effect: 

 

Look at ‘OFFICER’. Left is a baseline, right is an envelope. 
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Cut-Files 
Once a patch shape is made, but before duplicating it, if sewing as two parts, you can export the 

shape directly to a file for use in electronic cutting machines. Some machine files are supported 

directly, but you can also export a .svg file for import almost everywhere. This is accessed from the 

File menu > Export Outlines. 

 

Saving Files 
If you’re new to embroidery software, you need to know that there are files which contain 

information for the program, known as working files, and files that only contain instructions for 

the machine, known as stitch files. Always save your working file as this lets you edit your patch if 

you need to in the future. The stitch file is available in almost every machine format: .DST for 

commercial, .PES for Brother, .EXP for Bernina, .JEF for Janome, etc.  

 

Backings and Stabilizers 
Some patch makers sew directly onto fabric yardage, and they use any normal stabilizers for that 

purpose. The patches are then cut out from the fabric with a hot knife. The trouble with this 

approach is that you can give the patch burned edges which show. The advantage  is speed, as the 

maker can cut lots of patches out in a short amount of time. The selection of cloth is very 

important. 

Some patch makers will prefer to have the embroidery machine do everything, including making 

the fabric via a freestanding fill. For this approach, a wash-away fibrous stabilizer is used, just as 

with any freestanding lace project. Another option for this is clear vinyl. If you recall the clear 

furniture covers that were common in the 1960s and 70s, that horrid material is still available and 
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for better use: To make patches. It is very inexpensive and available at super ‘Mart’ stores. A third 

option is to use a soft cut away mesh. You’ll have to trim the edge very closely, but the patch looks 

great. If you have fibers protruding from the edge after cutting, you can try heating them away or 

simply color them with a marker. 

Using traditional applique techniques is a smart way to make the patch. The cut -in-the-hoop 

method uses the position stitch to mark the placement, and the material stitch to hold it down. 

Then the user will hand cut around the patch. This is difficult for complex shapes. For that reason, 

you may want to pre-cut the patch shape by hand or using a cutting machine. The wash-away or 

clear vinyl backings are good for this approach, the same as the freestanding option mentioned 

above. 

Fabric 
If you are going to use heat, 100% polyester is the desired material, unless there’s another option 

that heats or melts away. The typical fabric weave is twill. Poly twill is often sold by patch supply 

companies, and online, but can be harder to find in local fabric shops. The cotton/poly twill is far 

more common. Do not plan to melt that, because you cannot.  It is fine for applique methods. 

Sometimes a decorative topping is used for effect. Normally this is added before the material step 

is sewn. 

Thread 
The edge stitch is designed to use 40wt thread. Using a thicker thread will likely cut out the patch 

from the stabilizer, and a thinner thread will cause the edge to a bit less dense, which may still be 

usable. 

Read On 
For plenty more instruction on the Embrilliance Platform itself, please (please!) familiarize yourself 

with the manual. There is a lot going on in the platform to help you make your embroidery project 

perfect. You may also find that Merrowly is a perfect companion to other titles, such as Essentials 

which will allow stitch-file design resizing, removing hidden stitches, additional fonts and more.  

Happy Patch-Making! 

 
For fun, the following pages are reproduced from the Embrilliance website, to explain the patch 

edge stitch and its history…  
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A-Merrowly We Go! 

Or 

The Story of a Stitch 150 Years in the Making 

The What 
Patches. Emblems. Crests. Originally, they were used in garment repair, then for the military, now 

everyone is crazy about the humble patch. It’s retro, yet modern. It is portable, desirable and appeals to 

our tribal nature. We go to an event, let’s get a patch. We love a team, visit a park, or take a ride, get a 

patch. Collect ‘em all! 

How do you take a stock work shirt and brand it to a specific company? Add a decoration with the image 

of that company’s mark upon it. How to further identify a specific worker? Add a decoration with the 

name. The emblem and patch have allowed the decoration industry to solve these issues, using 

affordable ready-to-wear items with added inexpensive emblems that could be sewn on either at the 

decorator’s shop or by the customer. 

If you have ever held a patch, the edge that you have on that patch is an overlock stitch, with almost no 

exception. The trouble is that it requires a patch maker to own a machine, which, new, can be up to a 

few thousand dollars U.S. 

 

A couple test stitchouts on wash-away, along with our wood burner 

The When 
Back in the days of the American Civil war there were textile machines being invented, including chain 

stitchers and overlocks, the precursors to what today are called sergers. Wilcox and Gibbs, the John 

Merrow Company and others were running textile factories and they invented machines to help their 

production. If you are a fan of history or the history of textiles in particular, there are some amazing 

stories from that time period and those two companies. One of my favorites is that Wilcox and Gibbs 

were partners, but found themselves in opposite geographic regions during the American Civil war. At 

the conclusion of the war, James Gibbs had to walk from Virginia to the W&G office in New York. He 

goes in and is not only greeted by his partner, but his share of the company and profits had been 

faithfully preserved for him. They still produce machines to this day. 
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John Merrow, under a couple company names, used and sold machines that overlock to create refined 

edges on knit blankets. That overlock stitch and process came to be known as merrowing, an ironic use 

of the company’s trademarked name as a generic term, but useful for marketing the machines forever. 

In fact, most of the patch or emblem factories today are using machines made by The Merrow 

Company™. 

Let me state here that if you are going to make hundreds or thousands of patches, 

please buy a machine and learn to use it. It is going to save a ton of time in 

production. 

The Who 
There have been efforts at making a merrow-like motif stitch going back for many years. I wasn’t 

thinking hard about it back then. 

In 2010 or so, I was approached by my good friend, Gary Walker of Echidna Sewing Products in Brisbane, 

Australia. He was asking me to make a ‘patch’ Interactive. Patches were popular then, being cyclic in 

popularity similar to roller skates, Hula Hoops, Frisbee golf and bell-bottoms. I started to think on it, but 

other things took priority. 

In 2018 my friend Erich Campbell showed me some stitchouts of his attempts at a faux merrow stitch. 

He had even taught the idea to a few attendees at his commercial apparel decoration seminars, having 

used his stitch for customers a couple years prior. His stitch consisted of a motif that ‘hooked’ around a 

fan of stitches, resembling a merrow on a straight or lightly-curved edge.  

 

2014 file from Erich Campbell 

We spent some time fooling with it through 2019 and decided that the real solution was to 

programmatically generate the stitch. Early attempts were good, but the project wasn’t turned into a 

product for lack of time. 

In 2020, one of our friends, Jeff Fuller over at embnerd.com, showed a refined version of that stitch. This 

chain-and-fan motif does a nice edge, but it still has shape limitations, though, and requires some skill to 

make custom patch shapes. Similar versions of the stitch have since been presented by other well-

known digitizers. They all have the same difficulties, and you need specific files, which cannot be resized, 

for your project. 
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The recent resurgence in patch making sparked our interest in the programmed stitch again. Erich has 

long been asked about and has taught patch making to commercial embroiderers. The idea for it as a 

stitch in StitchArtist and possibly as a product started to form up. 

In February of 2021, I decided to break from the project that I was working to give Erich a birthday 

present. I wanted to finish the stitch. The idea came fully formed in my mind, so I made some initial 

programmatic trials, Erich, Lisa Shaw and some of our team began test sewing, and the result was what I 

wanted: A truer-looking overlock stitch. 

The Stitch (for insane digitizers only) 
The first stitch I made was too normal – most merrowing operators push the machine, especially on 

curves, so the fan exaggerates at an angle. I took this into account and redesigned it for the fan to cover 

the preceding stitch. Then, rather than using a triangle, I decided to see the stitch from its center – 

where the fan collects under the single needle topstitch. The loopers form, well, loops, around the 

needle. But if you look at it differently, you see a ‘mustache’ on either side of the stitch. It was this 

which gave the inspiration for the final look.  

 

Most patches don’t show the loop this clearly. 

The first of the fan stitches would come up, under the running stitch (needle) and cross to the next 

stitch. By doing this before the rest of the stitch was formed, those other stitches push against it, 

causing a slight curve to it, more closely resembling the mustache of the original. Well, it was as close as 

I was going to get, and at any distance, you cannot tell a real merrowed edge from our embroidered 

simulation. 

 

The embroidered edge stitch in testing 

Next was the slight problem of the machine capability. Merrow machines can go around tight curves – 

to the right. But they cannot make good lefts, or corners. How do we make corners? Well, on an 

overlock, you lift the presser foot, free the material from the needle plate, and turn the fabric to start a 
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new run of stitching. If we want to really make hard corners that look merrowed, we cannot simply turn 

and shortstitch, like we do all the time in embroidery. Rather, we have to simulate the idea of the 

operator lifting the presser foot. This means some code had to be written to break the path into 

‘overlocked strokes,’ which then get a lapped edge effect.  

 

On-screen is not the embroidered result. 

Remember to digitize for the medium, embroidery, not the screen! 

Another issue to solve was that the overlock is driven by the needle, which is well inside the shape. The 

outline had to be set according to pre-cut shapes from bought patches or from cuts made by an .svg file 

on a fabric cutter. It’s a very unusual problem to solve with an embroidery stitch. Fun, fun. 

The result is a stitch that looks like a merrowed or overlocked edge, but one which 

can be done on things impossible to actually merrow. 

Working until mid-March on the product and documentation, the Embrilliance Edge stitch formed up. By 

St. Patrick’s Day, the stitch was present in StitchArtist 3, ready for testing. 

 

Left and Center, 2 current patches from BSA, patch on right is an early test sample of our stitch. 

The How 
You have an embroidery machine and you know that you can make patches. But how? This isn’t a 

treatise on the entire patch making art, but we’ll provide an overview.  
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Patches, unlike normal decorative embroidery should be stiff in hand, almost ‘bulletproof’. They are 

usually made on twill that’s been fused to something very stable. There are patch making backings 

aplenty (like buckram or crinoline) for the purpose, but any fusible or even a really good adhesive 

stabilizer can make a decent patch. 

 

Comparing faux merrowing to a satin border. 

 

Another border comparison. 

When making a twill patch, you start with the color twill you need. If you cannot find the correct color, 

you can get something close, or white, and do a light fill to cover the fabric. This ‘sketch fill’ provides 

color and texture, and generally will not cause density issues with the design that goes on the patch. 

Military patches often have the sketch fill look, or so I’ve been told. 
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Left: The trouble with not fusing your twill. Right: Fused sample. 

Shape impossible for a real overlock machine. 

Alternately, if you’re really desperate, you can use a layer or two of wash-away mesh stabilizer and 

make the fabric using freestanding-fill stitches. This four-pass fill will create the fabric background for 

you, but it does take time, so it isn’t recommended for production purposes. Note that using a 

freestanding process will limit your ability to lay down very small stitches with as much precision, so if 

your patch uses tiny lettering, you really will prefer twill. 

Generally, the patch is made complete, before the design is added. There are times, where the design is 

heavy, that you might want to do the topstitching after the design. This allows for some pull of the fabric 

during sewing, meaning the topstitch can be done in a more regular shape, outside of whatever 

happened during the design sew out. This format is best on patches that will be cut out after the design 

is done, as opposed to anything precut, such as an applique-style patch. 

Patches are normally made on a larger span of cloth, and then cut out. This is opposed to the traditional 

applique method of cutting the applique either ahead of time or by hand in the hoop. This is not to say 

you cannot do this, and one feature of our stitch was to allow for those options by altering the insets 

and types of material tackdown stitches offered. You can even save an .svg file for use in a fabric cutter 

to pre-cut your patches. There are a bunch of options, so find something that works for you. 

When cutting out of cloth (polyester or something that melts), a hot knife is used, but you can use you 

curved snips too. Once the patch is trimmed as close as you dare, without cutting threads, heat is 

applied to seal off any fibers, trims or other ‘pokies’ that remain. The heat used can be from a hot knife, 

woodburning tool, or even a lighter, if your hand is steady. 
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Testing a complex shape using no fabric. Note edge needs final treatment. 

Patches can be made using other films, tear-away or wash-away, as hooped stabilizer, and the applique 

method of laying the patch into a position stitch can be used. This improves edge removal, but requires 

the backing removal. If you use this method, split the patch into two objects, sewing the topstitch after 

the design, as the needle penetrations will weaken the stabilizer and perforation can occur which can 

affect the registration of the design. Moving the topstitch to sew after the design, the stabilizer has a 

better chance of doing its job. 

Once the patch is made, there are backings to apply – things like the fusible patch-back which allows the 

end user to iron the patch on. There is a whole industry that makes those products, so we’ll let you 

discover about their processes from those suppliers. 
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Something a little bit different. Background is no-show mesh. 

When sewing a patch on, sew in the area where the ‘gaps’ in the overlock appear. You can also use an E 

stitch if you’re familiar with it. Use something stronger than embroidery thread. 

Thanks to my team for the help with testing! No, there are no designs available. Please make your own! 

We wish you Happy and Successful patchmaking! 

-Brian and Team Embrilliance 

P.S. I knew there would be questions about the overlock / merrowing. Here are some answers. 

Why isn’t the width adjustable? 

This is one of those places where, as embroiderers, your screen is lying to you. (Not surprising, is it?) The 

standard width of 3/16” will work on any patch from under an inch to several inches and it will not look 

imbalanced when sewn. That's why it hasn't been changed in a century. Yes, we could provide some 

variability, but until you have sewn a lot of them, you really have no idea what you're doing. And, "If it 

isn't broken, don't fix it." 

As to sewing order, patch edge first or last? 

Just sew it first. Even on wash-away? Yes, most people use two layers. Once you're familiar with it, feel 

free to play. It's going to be extreme where the design pulls the patch sideways enough to run into the 

border: Leave some space between your design and the edge, and you'll have little issue. Let it breathe - 

whitespace of 5mm or 1/4" is normal. You will not pull that much unless you have poor embroidery 

technique. (This has happened to all of us but is easily corrected). 

Can’t I just use wash-away for all of them? 

While it is tempting to do it all on wash-away, that's okay but not your best result for a lot of stitches. 

Please play with fused or well-stuck poly twill and if it is the wrong color, use the light top-fill. You'll 

learn some things you can get away with, and things you can't. 

Is there something better? 

Another very viable option that you all should have is 'non-showing' mesh cut-away. It's super stable 

and heats off the edge (once you cut it close) very safely. You can use the normal freestanding fill option 

with it, too. One layer will do. 

What about patch firmness? Do I need that ‘bulletproof’ feel? 

Most people want somewhat floppier patches than we used to see, and this is the norm today. If you 

really want an old-school stiffened patch, you might want to use the position step on some cut-away or 

other crinoline-like fabric, maybe even a tight tulle. Sew the position step onto the stabilizer and then 

cut out around the position line. You now have an applique that can be applied after the position run 

when sewing the patch itself. 

Can you pre-cut the patch using an electronic cutter/plotter?  
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Sure! The position step can be saved as an .svg, .cameo or another cutting file directly from StitchArtist. 

The easy way is to select the shape of the patch, and use the menu File-> Export Outlines. Cut the patch, 

making sure you have something stable enough to cut. Don’t just cut a loose piece of fabric – it won’t 

cut well by itself – but if you’ve been using your cutter, you probably know all about that. Again, with a 

precut, place it after the position stitch runs for the patch. 

When placing something such as a pre-cut fabric or stiffener, use something to hold it in place. A little 

spray adhesive will do. It only has to hold well enough for the next bit of stitching in the patch, the 

material tacking run, which anchors it to whatever you have hooped. A note about spray adhesives: 

They are NOT all the same. The KK2000 is evaporative (volatile) meaning that it goes away completely, 

whereas the 505 will leave your carpet sticky until it has collected all the dirt it can attract. Have a read 

on them, and you’ll understand why some are ‘dirt’ cheap and others aren’t. 

What’s the difference between the pre-cut setting and the hand-cut? 

The inset required for hand cutting needs to be greater because you and your snips just aren’t as 

precise. 

Sew the patch edge before or after the design? 

If you’re not applying anything, and sewing on yardage, you can stitch the edge after the design. It won’t 

help in any way, normally, but there you go. 

There might be some odd occasion where you want to sew the patch edge after the design is done. It 

isn’t necessary, really, almost never, but as there are no absolutes in this, copy the patch shape, place 

one before the work you’re doing on the patch and turn off the topstitch. Paste another copy after the 

sewing on the patch will be complete, and only use the topstitch. There, not difficult, but again rarely 

necessary. (I’ve never needed to do it this way.) The only reason for this that I have ever been given is 

when the patch design is very stitch-intensive, and then the edge should run later. This means, of 

course, that the position stitches will have moved, and may be visible when done.  

Remember, if you’re running yardage, and no applique step, you can, of course, sew the edge entirely 

after the design. Your choice. 

Do this if you can’t stabilize your patch properly. And if that’s the case, re-evaluate the design, please. 

Why doesn’t the patch pull around? 

Because you’re sewing a patch, which is a small design that mainly uses satin columns, and very few fills, 

if any at all. Think about keeping your stitching light and you won’t have any issue with the patch edge 

being sewn there already. 

The edge stitching has been shown not to cut out the stabilizer to an unusable point. The density is well 

within the norm. The edge covers well because of layers, but they leave the stabilizers intact. 

How about the Badgemaster™ and other heavy-weight patch making stuff?  

Yes, it exists for a reason. If you can acquire some to experiment with, please do. Will you need it? No, 

probably not. 
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What about other toppings? 

If you want a decorative effect, adding transparent film, such as Mylar, to the surface of the patch, 

placed after the position run, is a well-known technique. You can usually cut and heat-away this after 

the fact, but you can also treat it like a normal applique and hand-trim it in the hoop after it has been 

sewn down by the material run. A common variant of this is to additionally add the light fill for texture. 

How do commercial embroiderers do this?  

As many ways as you can laugh. But commonly they take the patchmaking twill, fused as I’ve been 

saying, and sew the patch design on it. After the design is sewn, they then cut the patch shape out of the 

cloth. Next it gets the fusible backing or whichever is required. Finally, it is sent to someone who runs 

the merrowing step. If they are doing a large quantity, they do more than one in a hoop, and they 

roughly use the same guide as you would when digitizing for a hat: They sew from the center out. And 

when they cut the patches out, they generally use a hot knife to cut with. 

Do I need to stick with poly? 

Yes, remember to use polyester twill. It will melt away at the edges nicely. 

Ok, now you may want the Velcro. The hook goes on the patch. It’s not really best to sew it on because 

it will come loose if it is repeatedly taken on and off, and you need a heavy nylon thread to do it 

properly anyway. Get some hook-and-loop that’s adhesive, or, better in my mind, hot glue it in place. 

Again, there may be some hook-and-loop that’s premade for patches, but you’ll need that pesky heat 

press for it. 

We didn't want to overwhelm you, and there is little benefit from the dozen or so commercial assembly-

line variations for you if you're making a handful. Worse, there will be no rules, no absolutes, none of 

the usual: "The right way to do this is..." because the real answer is always, "Well, it depends." 

All the variants, underlays, backing materials and sundry 'patch-kit-stuff' like you see from Colman and 

Company will probably be overwhelming to you as a novice patchmaker. And you probably don't have a 

commercial heat press. Rowenta irons, nice as they are, don't count. But there are plenty of Dritz-type 

solutions available in any fabric shop, if you want to play with backings, and they are designed for your 

irons. The pros back the patches with a double-sided heat and fuse backing that’s thick, so it requires a 

heat press to apply it well to the patch. 

Make some fun patches and play with materials. It is a rather forgiving process. Not everything has to be 

hard. (Not even finished patches!) Once you have done a couple handfuls, try ordering in some of the 

patch making stuff. There are buckram and similar backings, but I bet you have something in one of 

those plastic tubs which we all have, and that'll do for now, to experiment with. 

Seriously, don’t worry about the complex stuff. I have in my hands, the main BSA patch shown above. It 

has only a tear-away stabilizer, torn away, under a piece of twill. It was then heat-pressed with the 2-

sided heavy heat-fuse stuff (with a custom imprint!) and then merrowed. Your work will look even 

better. 

Try it, and I think you'll understand very quickly how powerful the simple versions can be. In this case, 

one patch is worth a thousand words. 
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We're watching closely to see how to improve the process for you. 

I hope this helps some of you feel more ready to play! 

Cheers! 

-Brian 


